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PowerQuest® Server License Agreement

IMPORTANT: Read this before using your copy of PowerQuest software.

This document is a legal agreement between you (an individual or business) and PowerQuest Corporation (PowerQuest). Use of the 
software indicates your acceptance of these terms. As used in this License Agreement, the term "Software" means the software 
included on the CD or disk media provided with this License Agreement. The term "Software" does not include any software that is 
covered by a separate license offered or granted by a person other than PowerQuest.

IF YOU DO NOT AGREE TO THESE TERMS AND CONDITIONS, EITHER DESTROY OR RETURN, INTACT, THE 
SOFTWARE PACKAGE, CONTAINING THE CD OR DISK MEDIA, TOGETHER WITH THE OTHER COMPONENTS OF 
THE PRODUCT TO THE PLACE OF PURCHASE FOR A REFUND OF THE PURCHASE PRICE.

1. PROPRIETARY RIGHTS. The Software and any accompanying documentation are the proprietary products of PowerQuest or 
its licensors and are protected under national laws and international treaty provisions. Ownership of the Software and all copies, 
modifications, translations, and merged portions thereof shall at all times remain with PowerQuest or its licensors.

2. GRANT OF LICENSE. The Software and accompanying documentation are being licensed to you, which means you have the 
right to use the Software only in accordance with this License Agreement. The Software is considered in use on a computer when it 
is loaded into temporary memory or installed into permanent memory. This License may not be assigned or otherwise transferred 
without prior written consent from PowerQuest, and any unauthorized transfer is null and void.

PERSONAL LICENSE. This license is personal to you. You may not sublicense, lease, sell, or otherwise transfer the Software or 
any of the accompanying documentation to any other person. You may use the Software only for your own personal use if you are 
an individual, or for your own internal business purposes if you are a business. If you are a service bureau, integrator, value added 
reseller, or other type of service provider and wish to use this software on your clients' computers, you must purchase a 
Configuration License.

SERVER-SPECIFIC LICENSE. Each permitted copy of the Software may be used only in connection with one network server 
owned or leased by you. Once a copy of the Software has been used on a server, it may not be used on any other server. If the 
Software is made available on a network, it may be accessed only by ONE specific computer. Once the Software has been accessed 
by ONE specific computer it may not be used on any additional computers without purchasing additional licenses.

NUMBER OF COPIES LICENSED. You are authorized to use ONLY a single copy of the Software on the number of servers for 
which you have purchased a license as indicated on the accompanying license certificate. All copies of the Software must include 
the copyright, trademark, and patent notices.

BACKUP COPY. In addition to any copies authorized under this license agreement, you may make a single copy of the Software 
solely for backup purposes.

UPDATES, UPGRADES AND SUPPORT. You are entitled to receive complimentary technical support as outlined in the 
Software documentation. You are entitled to receive Software updates (updates are indicated by version number changes to the 
right side of the decimal) in accordance with PowerQuest policies as announced from time to time on terms comparable to those 
offered to other users of the Software under the server licenses.

TERM. This license is effective from your date of purchase and shall remain in force until terminated. You may terminate the 
license and this License Agreement at any time by destroying the Software and the accompanying documentation, together with all 
copies in any form.

3. NONPERMITTED USES. Without the express prior written permission of PowerQuest, you may not (a) use, copy, modify, 
alter or transfer, electronically or otherwise, the Software or documentation except as expressly permitted in this License 
Agreement, or (b) translate, reverse program, disassemble, decompile, or otherwise reverse engineer the Software.

4. EXPORT CONTROLS. Certain uses of the Software by you may be subject to restrictions under U.S. regulations relating to 
exports and ultimate end uses of computer software. You agree to fully comply with all applicable U.S. laws and regulations, 
including but not limited to the Export Administration Act of 1979 as amended from time to time and any regulations promulgated 
thereunder.

5. U.S. GOVERNMENT RESTRICTED RIGHTS. If you are acquiring the Software on behalf of any unit or agency of the 
United States Government, the following provision applies:  It is acknowledged that the Software and the documentation were 
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developed at private expense and that no part is in the public domain and that the Software and documentation are provided with 
RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government is subject to restrictions as set forth in subparagraph 
(c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) 
of the Commercial Computer Software-Restricted Rights at 48 CFR 52.227-19, as applicable. Contractor/Manufacturer is 
PowerQuest Corporation/P.O. Box 1911/Orem, UT 84059-1911/U.S.A.

6. LIMITED WARRANTY. (a) PowerQuest warrants to you, the original end user, (i) that the Software, other than third-party 
software, will perform substantially in accordance with the accompanying documentation and (ii) that the Software is properly 
recorded on the disk media. This Limited Warranty extends for ninety (90) days from the date of purchase. PowerQuest does not 
warrant any third-party software that is provided with the Software, but PowerQuest agrees to pass on to you any warranties of the 
owner or licensor to the extent permitted by the owner or licensor. (b) This Limited Warranty does not apply to any Software that 
has been altered, damaged, abused, mis-applied, or used other than in accordance with this license and any instructions included on 
the Software and the accompanying documentation. (c) PowerQuest's entire liability and your exclusive remedy under this Limited 
Warranty shall be the repair or replacement of any Software that fails to conform to this Limited Warranty or, at PowerQuest's 
option, return of the price paid for the Software. PowerQuest shall have no liability under this Limited Warranty unless the 
Software is returned to PowerQuest or its authorized representative, with a copy of your receipt, within the warranty period. Any 
replacement Software will be warranted for the remainder of the original warranty period or 30 days, whichever is longer. (d) THIS 
WARRANTY IS IN LIEU OF AND EXCLUDES ALL OTHER WARRANTIES NOT EXPRESSLY SET FORTH HEREIN, 
WHETHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE, NON-INFRINGEMENT, OR WARRANTIES ARISING FROM USAGE OF 
TRADE OR COURSE OF DEALING. (e) THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS; YOU MAY HAVE 
OTHERS WHICH VARY FROM STATE TO STATE. (f) Your failure to return the enclosed registration card or complete the 
electronic registration included with the Software may result in PowerQuest's inability to provide you with updates to the Software, 
and you assume the entire risk of performance and result in such an event.

7. LIMITATION OF LIABILITY. IN NO EVENT SHALL POWERQUEST'S LIABILITY RELATED TO ANY OF THE 
SOFTWARE EXCEED THE LICENSE FEES ACTUALLY PAID BY YOU FOR THE SOFTWARE. EXCEPT FOR A RETURN 
OF THE PURCHASE PRICE UNDER THE CIRCUMSTANCES PROVIDED UNDER THE LIMITED WARRANTY, 
NEITHER POWERQUEST NOR ITS SUPPLIERS SHALL IN ANY EVENT BE LIABLE FOR ANY DAMAGES 
WHATSOEVER ARISING OUT OF OR RELATED TO THE USE OF OR INABILITY TO USE THE SOFTWARE, 
INCLUDING BUT NOT LIMITED TO DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, 
AND DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, 
OR OTHER PECUNIARY LOSS, EVEN IF POWERQUEST CORPORATION HAS BEEN ADVISED OF THE POSSIBILITY 
OF SUCH DAMAGES, WHETHER SUCH LIABILITY IS BASED ON CONTRACT, TORT, WARRANTY, OR ANY OTHER 
LEGAL OR EQUITABLE GROUNDS. BECAUSE SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION 
OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO 
YOU.

8. NO WAIVER. Any failure by either party to this agreement to enforce a specific part of the agreement in a specific situation is 
not a waiver of rights under the agreement. The party may still enforce the rest of the agreement in that situation and may still 
enforce some or all of the agreement in other situations.

9. This License Agreement constitutes the entire agreement between you and PowerQuest pertaining to its subject matter. This 
License Agreement is governed by the laws of the State of Utah. Any litigation arising from this license will be pursued only in the 
state or federal courts located in the State of Utah. Even if part of the agreement is held invalid, the rest of the agreement is still 
valid, binding and enforceable.

Should you have any questions concerning this Agreement, or if you desire to contact PowerQuest Corporation for any reason, 
please write:  PowerQuest Corporation/P.O. Box 1911/Orem, UT 84059-1911/U.S.A.

© 1994-2000, PowerQuest Corporation. All rights reserved. The Software is protected by U.S. patents, with other patents pending 
in the U.S.A. and elsewhere. PowerQuest is a registered trademark of PowerQuest Corporation.
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Introduction

What Is Server Image?

Server Image is a fast, inexpensive, and complete hard-disk imaging solution. Unlike 
file-by-file copying utilities, Server Image uses SmartSector® imaging to create an exact 
image of a hard disk or partition.

With Server Image, you can create and restore a compressed image file of an entire hard 
disk or individual partitions of a hard disk. Because Server Image uses SmartSector 
imaging, your Windows optimizations are preserved when you restore an image. Server 
Image provides SmartSector imaging support for FAT, FAT32, NTFS, HPFS, and Linux 
Ext2 and swap file systems.

IMPORTANT! Because of operating system conflicts that can result from different 
hardware configurations, Server Image was not intended to copy or image 
a hard drive that will be used in a system with different hardware 
configurations.

Server Image System Requirements

Hardware/Software Minimum

Processor Intel 386SX (486 or above recommended)

RAM 16 MB (32 MB required for FAT32 or NTFS); 32 MB 
recommended

3.5-inch diskette drive None; 3.5-inch diskette drive recommended

CD-ROM drive Any speed

Hard disk free space 8 MB

Operating System Windows NT 4.0, Windows 2000, or DOS 5.0

Monitor VGA; SVGA recommended

Pointing Device None required; Microsoft mouse recommended
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C H A P T E R1
Getting Started
This chapter includes the following information:

• Installing Server Image

• Before Running Server Image

• Running Server Image

• Uninstalling Server Image

• Getting Online Help
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Installing Server Image

You can install Server Image from Windows NT Server 4.0 or Windows 2000 Server.

1 Insert the ServerMagic CD into your CD-ROM drive.

Server Image is included on the ServerMagic CD.

If CD auto-run is enabled, the installation program automatically launches when you 
place the ServerMagic CD in your CD-ROM drive.

2 If the CD auto-run is not enabled, insert the CD, click Start ➤ Run, then type 
drive:\autorun (where drive is the drive letter of your CD-ROM drive), then 
click OK.

3 Click Install.

The Installation Options dialog appears.

4 Select Server Image, then click Next.

5 Follow the on-screen commands.

Server Image runs under DOS, so the installation program creates a “virtual floppy” 
to run the program.

Creating Server Image Rescue Diskettes

At the end of the installation process, you will have an opportunity to create rescue 
diskettes.

To create rescue diskettes after the installation is complete:

1 Insert the ServerMagic CD.

2 At the browser, select Technical Support.

3 Click Create Server Image Rescue Diskettes.

PowerQuest recommends that you create rescue diskettes. Then if your hard disk becomes 
unbootable or you do not have access to a Windows server, you can boot your computer 
and run Server Image from the rescue disks.

You will need two blank diskettes to proceed (You need three diskettes if you are creating 
Server Image in a double-byte language.)
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Limitations of Server Image Rescue Diskettes

Be aware that when you run Server Image from the rescue diskettes you cannot save 
images to the following partitions:

• FAT32 or NTFS partitions
• Any partition that crosses or exists past the 1024 cylinder boundary
• Any partition that resides in an extended partition that crosses or exists past the 1024 

cylinder boundary

You can avoid these limitations by using a DOS 5.x or later boot floppy in place of the 
Server Image bootable diskette (diskette 1 of the 2-diskette set). Creating your own boot 
floppy will also enable you to access network drives, which you cannot do with the rescue 
disks or the product running from your hard disk after a typical installation.

Before Running Server Image

Before running Server Image, PowerQuest recommends that you:

• Run a disk utility such as CHKDSK /F on each partition of the source drives to check 
for file system errors.

• Create Server Image rescue diskettes. 

Running Server Image

You can run Server Image from the rescue diskettes or from your hard disk.

Running Server Image from Rescue Diskettes

1 Insert a bootable diskette (such as Diskette 1 of the Server Image rescue diskettes).

To create rescue diskettes, see “Creating Server Image Rescue Diskettes” on page 4.

2 Reboot your machine.

DOS loads and displays a prompt to insert the second Server Image rescue diskette 
and press any key to continue.

3 Insert the Server Image program floppy (Diskette #2 of the Server Image rescue 
diskettes), and press <Enter>.
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The boot diskette includes EMM386.EXE to help load network drivers in high memory. 
However, because this file limits extended memory to 32 MB, you may see error #3 when 
you run Server Image from the rescue disks and work with large FAT32 and NTFS 
partitions. If you do not need EMM386.EXE, you can delete it from the bootable floppy to 
avoid this error. If you delete the EMM386.EXE file, you must also REM or delete the 
following line in the CONFIG.SYS file on the boot floppy: DEVICE=EMM386.EXE.

Running Server Image from a Hard Disk

1 Click Start ➤ Programs ➤ PowerQuest ➤ Server Image 1.1 ➤ Server Image 1.1.

Uninstalling Server Image

1 Click Start ➤ Programs ➤ PowerQuest ➤ Server Image 1.1 ➤ Uninstall Server 
Image.

You can also click Start ➤ Settings ➤ Control Panel ➤ Add/Remove Programs ➤ 
Server Image 1.1.

2 Follow the instructions on the screen.

Getting Online Help

1 Click Help ➤ Contents to display general instructions for using Server Image Help, 
or press <F1> at any time to access the Help Index.
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C H A P T E R2
Creating Image Files
This chapter includes the following information:

• Image Files and Hardware Configurations

• Copying Windows NT Partitions

• Using Server Image to Image Windows 2000 Server

• Before Running Server Image

• Creating an Image File

• Advanced Options
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Image Files and Hardware Configurations

Because of operating system conflicts that can result from different hardware 
configurations, Server Image was not intended to copy or image a hard drive that will be 
used in a system with different hardware configurations.

If you create an image on one machine and restore the image on a machine with a different 
configuration (for example, a different motherboard or video card), the operating system 
may not boot correctly. Therefore, PowerQuest recommends imaging and restoring only to 
machines with identical hardware configurations.

Copying Windows NT Partitions

If you are using Server Image to copy Windows NT partitions (where Windows NT is 
installed), you may experience problems related to the Windows NT BOOT.INI. The 
Windows NT BOOT.INI includes information about the boot options for Windows NT’s 
loader and the order of the Windows NT partition. If you have used Server Image to copy 
a Windows partition, and the partition order has changed from the original order, then the 
BOOT.INI may not be updated to reflect the new order of the Windows NT operating 
system files. Therefore, you will be unable to boot your NT Workstation partition.

PowerQuest has developed a solution (in English) that will allow you to update and edit 
the Windows NT BOOT.INI. The executable is NTFSINI.EXE. For additional 
information, see the PowerQuest web site www.powerquest.com/support/pm/pm6076.html. 

Using Server Image to Image Windows 2000 Server

1 Follow the setup instructions to install Windows 2000 Server to the computer.

2 On the first boot-up that actually goes into Windows 2000 Server, you will have an 
option to set up the server in one of many ways. Do not select any option.

3 Close the server setup window.

4 (Optional) Use Microsoft’s SysPrep to remove machine-specific entries to allow 
deployment to several identical computers.

5 Shut down the machine.

6 Reboot the computer using the Server Image rescue disks.
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You may need to create and use your own boot floppy that will enable access to a data 
storage region large enough to store the image of the Windows 2000 Server system.

7 Image the Windows 2000 Server system.

When the system is restarted, the server setup screen reappears.

PowerQuest only supports the imaging of a Windows 2000 Server that has not had its 
server responsibilities set. If SysPrep has been applied to the system before the image is 
taken, then the image can be restored to other identical machines.

Be aware that when you run SysPrep, you are subject to Microsoft’s technical restrictions 
on using SysPrep. For example, imaging to machines with different hardware is not 
directly supported by Microsoft.

Before Running Server Image

• Before running Server Image, use a disk utility program such as a thorough ScanDisk 
or Norton’s Disk Doctor to identify and repair any errors on your hard disk.

Windows NT Workstation users should run CHKDSK /F.

• You must disable virus detection in the BIOS before creating an image file.

If virus protection is enabled, Server Image may report an erroneous virus when your 
start up or Server Image may hang after you click Finish.
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Creating an Image File

1 At the Server Image main screen, click Create Image.

The Select Source Drive screen appears.

2 Select the disks that include the partitions you want to include in the image file.

You can click All Disks to select partitions from every hard disk on your machine.
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The Select Source Partition(s) screen appears. It displays all the partitions on the 
disks that you selected. The partition map near the top of the screen is a graphic 
display of your hard disk. It includes a blue indicator for the 2 GB boot code 
boundary and a black indicator for the 1024 cylinder limit.

3 Select the partition you wish to include in the image file (the source partition) from 
the partition list, or click Select All to automatically select all partitions.

You may need to scroll to view all the partitions on your machine. Note that if you 
have more than one hard disk on your machine, the first column in the partition list 
shows the physical hard disk where the partition is located.

To deselect partitions, click again on a partition or click Select None to deselect all 
partitions at once.

4 Click Next.
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5 Type the desired path and image filename in the Image File field (for example, 
D:\MYIMAGE.PQI).

You must save your image file to a partition that you are not including in your image 
file. You can click Browse to find the directory where you want to save the image 
file.

IMPORTANT! You can save your image file to any physical or logical drive that DOS 
has assigned a drive letter. You can save images to a local NTFS 
partition only if DOS has assigned it a drive letter. If you are running 
Server Image from rescue diskettes, be aware of the limitations listed 
on page 5.

IMPORTANT! Do not include spaces or extended characters (;+=[]',\"*\\<>/?:|) in the 
filename, or you may not be able to access the image file from Server 
Image or DOS.

Make sure there is no existing file with the same name, unless you want the existing 
file to be overwritten. Server Image uses .PQI as the default image filename 
extension.

To save images to a network drive, you must boot from a floppy that includes 
network drivers. You can add network drivers to the first Server Image rescue disk, or 
boot your server from another floppy that includes the drivers.

6 (Optional) Type brief comments about your image file in the Image File Comments 
field.

Image file comments cannot exceed 300 characters.
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7 Click Next.

8 Select the desired compression level.

• No Compression is usually the fastest method for creating an image file and is 
useful if storage space is not an issue. However, if you are saving your image file 
to a busy network drive or to a relatively slow removable media device, high 
compression may be faster than no compression since there is less data to write to 
the file. Server Image selects No Compression by default.

• Low compression offers a 40% average compression ratio.

• High compression offers a 50% average compression ratio.

9 Click Next.

The Ready to Create Image File screen appears.
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Server Image displays all the information you have entered to this point.

To modify any settings, click Back.

10 (Optional) Click Advanced Options to split an image file into multiple files (for 
removable media), to disable file system error-checking or SmartSector copying, to 
password protect your image file, or to verify disk writes.

See “Advanced Options” on page 15 for additional information.

11 Click Finish to begin creating the image file.

If you entered a name of a current file (step 6), Server Image displays a message that 
<path and filename> already exists. You can replace the existing file or choose a new 
filename. If you click Replace, the existing image file will be deleted immediately.

If Server Image detects that you are saving your image file to a floppy drive or 
removable media, it enables a media-spanning feature that spreads the image file over 
a series of disks. You must have at least 100K of available space on each disk in the 
series. If you use the media-spanning feature, be sure to number the disks in order, 
since you must insert them in sequence when restoring the image file.
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The Creating the Image dialog appears.

Upon completion, the following message appears: “Image was copied successfully to 
file: <image filename>.“

12 Click OK to return to the Server Image main screen.

Advanced Options

The Create Image Advanced Options dialog appears when you click Advanced 
Options at the Ready To Create Image File screen.

Select this: To do this:

Check for File System 
Errors

Clear the Check for File System Errors check box if you 
want to disable error checking.

If you have already used a disk utility program such as 
ScanDisk to check your hard disk for errors, it is not 
necessary to have Server Image check for file system errors. 
Clearing Check for File System Errors saves time in 
copying the partitions.

If you did not run a disk utility program before loading 
Server Image, leave the Check for File System Errors 
check box selected.



Disable SmartSector 
Copying

Server Image’s SmartSector technology speeds up the 
copying process by only copying clusters and sectors that 
contain data. However, in some cases, such as high-security 
environments, it may be desirable to copy all clusters and 
sectors in their original layout, whether or not they contain 
data.

If you wish to copy both used and unused clusters and 
sectors, click Disable SmartSector Copying. Disabling 
SmartSector Copying increases processing time.

Verify Disk Writes Click this option to enable DOS disk write verification. If 
you choose this option, Server Image writes the data, then 
goes back and reads it to verify that is was written correctly. 
Disk write verification is not critical to safely create image 
files, but it reduces the chances that an image will be 
corrupted during the write process.

Enabling disk write verification can slow image file creation 
dramatically.

Password Protect 
Image File

To password-protect your image file, click Password 
Protect Image File and type a password in the Password 
field.

IMPORTANT! Store image file passwords in a safe place. If 
you forget the password, you cannot restore 
the file.

Split Image File Into 
Multiple Files

Sometimes it is useful to force Server Image to split a large 
image file into smaller files. To do so, click Split Image File 
Into Multiple Files and enter the maximum byte size for 
each file in the File Size (bytes) field. If you wish to save the 
files to CDs, specify a file size of 670,000,000 bytes 
(approximately 670 MB) or less.

Select this: To do this:
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C H A P T E R3
Restoring Image Files
This chapter includes the following information:

• Imaging Primary Domain Controllers

• Restoring an Image File

• Advanced Options
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Imaging Primary Domain Controllers

Exercise caution when restoring an imaged Primary Domain Controller. Server Image for 
Windows NT will automatically convert a PDC (Primary Domain Controller) to a BDC 
(Backup Domain Controller) when you restore the image file. If you want the restored 
image to be the PDC, you must promote a BDC to a PDC before restoring the image.  
Then restore the image. The image will be restored as a BDC. Next, promote the restored 
image server to become the PDC; when you do so, the promoted PDC will be demoted 
back to a BDC.

Restoring an Image File

1 Disable virus detection in the BIOS.

If virus protection is enabled, Server Image may report an erroneous virus when you 
start up or Server Image may hang after you click Finish to restore an image file.

2 At the Server Image main screen, click Restore Image.

3 In the Image File field, type the path and filename of the image file you want to 
restore, or click Browse to select the path and image file.

You can restore an image file from any physical or logical drive that DOS has 
assigned a drive letter, including floppy drives, secondary hard drives, network 
drives, and removable media storage devices. You may need to run Server Image 
from DOS boot diskettes to access network drives while running Server Image.

If you are running Server Image from rescue diskettes, be aware of the limitations 
listed on page 5.
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4 Click Next.

At any point prior to actual image file restore, you can click Back to return to the 
previous step and change your settings.

5 If there is more than one partition in the image file, you can select the partitions you 
want to restore. Click partitions to select them individually, or click Select All.

To deselect partitions, click again on a partition or click Select None.

6 Click Next.

7 From the Select Destination Drive dialog, select the disk that includes the 
unallocated space or partitions where you want to restore the image file.

Drag column borders to 
resize columns. Display 
whether an image file 
has a password, is 
compressed, or is 
spanned by dragging 
the right border of the 
Unused MB column 
right to display 
additional information.
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If you only have one hard disk, this step is omitted.

IMPORTANT! If you create an image on one machine and restore the image on a 
machine with a different configuration (for example, a different 
motherboard or video card), the operating system may not boot 
correctly. Therefore, PowerQuest recommends restoring only to 
machines with identical hardware configurations.

8 Select an existing partition or unallocated space where you want to restore the image.

The partition list includes all the partitions on your machine. If you have more than 
one hard disk, the first column in the partition list shows the disk on which a partition 
is located.

When you restore an image to unallocated space, Server Image creates a new partition 
for the image. The unallocated space where you restore an image must be at least as 
large as the used space required by the image. For example, if you created an image of 
a 500 MB FAT32 partition that included 300 MB of data, the unallocated space where 
you restore the image must be at least 300 MB.

Be aware that if you restore an image of a primary partition into unallocated space 
inside an extended partition, Server Image will create a logical partition for the image. 
Consequently, the partition will not be bootable. If you need a bootable partition, 
ensure that the Pri/Log column for the unallocated space displays Primary.

If the destination partition or unallocated space is not large enough to accommodate 
the partitions you wish to restore, or if you are restoring the image file to a larger 
drive and want to set a specific size for partitions rather than use the proportional 
resize option, you may want to resize the partitions.

If you restored an 
image of a primary 
partition into the 
selected 
unallocated space, 
it could be 
bootable. If you 
restored a primary 
partition into the 
other unallocated 
space in this 
graphic, it would 
become an 
unbootable logical 
partition.
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If you do not want to resize the partitions, go to step 14.

9 Click Resize Source Partition(s).

The Resize Partitions window displays.

The Selected Source Partition(s) group box displays the partitions you selected to 
restore.

10 Click Resize.

The Resize Partition window appears.

11 In the New Size field, enter the size for the new partition (in MB), then click OK.

The size you enter must be equal to or larger than the Minimum Size and less than or 
equal to the Maximum Size displayed in the dialog.

Since partitions must end on a cylinder boundary, Server Image rounds the new size 
up to the next cylinder boundary.

12 Click Accept.



Chapter 3: Restoring Image Files22

When you restore the image file, Server Image will resize the partition.

13 Click Next.

If you selected an existing partition as the destination, Server Image prompts you that 
the selected partition will be deleted before the image is restored. Server Image does 
not delete the partition until you click Finish on the Ready to Restore Image File 
screen.

14 If the unallocated space on the destination drive is greater than the space required to 
copy the selected partition, the Resize Options dialog appears. Click the option you 
want, then click OK.

15 Server Image displays all the information you have entered to this point. To alter any 
settings, click Back.

Select this option: To do this:

Automatically resize 
partitions 
proportionally to fit

Allow Server Image to automatically expand the 
partitions in equal proportions to occupy the destination 
drive’s remaining unallocated space.

Leave remaining 
unused space

Leave any remaining unallocated space unused on the 
destination drive after the partitions are copied.

Resize partitions 
manually to fit

Display the Resize Partition window where you can 
manually set the size of the partitions to fit in the 
destination drive’s remaining unallocated space. (See 
step 9 for additional information about the Resize 
Partition window.)
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16 (Optional) To check for file system errors, enable bad-sector checking, turn on DOS 
disk-write verification, or hide partitions after restore, click Advanced Options. For 
more information, see “Advanced Options” on page 24.

17 Click Finish to begin restoring the image file.

Restoring partitions can cause the drive letters of subsequent partitions to change. 
This may make the computer unbootable or cause applications to fail.

If you assigned a password to the image file when you created it, the Get Image File 
Password dialog appears. You must enter the password to restore the image file.

If Server Image detects that you are restoring your image file from a floppy drive or 
removable medium, it enables a media-spanning feature that is capable of reading the 
image file from a series of disks. As Server Image prompts you for each media, be 
careful to insert the disks sequentially.

The Restoring the Image dialog appears, tracking the progress of the image restore.

Upon completion, the following message appears: “Image was restored successfully.”

18 Click OK to return to the Server Image main screen.
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Advanced Options

The Advanced Options button is available on the Ready to Restore Image File screen.

Select this: To do this:

Check for File System 
Errors

Clear the Check for File System Errors check box if you 
want to disable error checking.

If you have already used a disk utility program such as 
ScanDisk to check your hard disk for errors, it is not 
necessary to have Server Image check for file system errors. 
Clearing Check for File System Errors saves time in 
copying the partitions.

If you did not run a disk utility program before loading 
Server Image, leave the Check for File System Errors 
check box selected. Server Image cannot restore images 
with file system errors.

Skip Bad Sector Check This is selected by default to save time in copying the 
partitions.

Although most drives do not have bad sectors, the potential 
for problems increases during the lifetime of the hard drive. 
If you have an older hard drive, it is wise to enable 
bad-sector checking by clearing the Skip Bad Sector Check 
box.

Verify Disk Writes Click Verify Disk Writes if you want to enable DOS disk 
write verification.

Disk write verification is not critical to safely copy files. 
Enabling disk write verification can slow the copying 
process dramatically.
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Hide Partition(s) After 
Restore

Most operating systems only allow one primary partition to 
be visible (bootable) at a time. If you are restoring a primary 
partition and you do not want to make that partition your 
bootable partition, the Hide Partition(s) After Restore box 
should be selected.

If you are using your secondary hard drive as a complete 
backup of your primary drive, selecting Hide Partition(s) 
After Restore preserves all the secondary drive information 
without changing any drive letters. When the computer 
boots up, a drive letter will not be assigned to the hidden 
hard drive. For additional information about hiding 
partitions, see “Hiding Partitions” on page 31.

Select this: To do this:
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C H A P T E R4
Common Partition 
Management Tasks
This chapter includes the following information about the Tools menu:

• Displaying Drive Information

• Creating Extended Partitions

• Deleting Partitions

• Hiding Partitions

• Setting the Active Partition
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The Tools drop-down menu on the Server Image main screen lets you manually perform 
some common partition-management tasks that Server Image automatically performs 
when it processes image files or when it copies partitions. The Tools menu gives you 
access to these useful features without requiring you to create or restore image files or 
copy partitions.

Displaying Drive Information

The Display Drive Information option lets you view information about the partitions on 
your current hard drive.

1 At the Server Image main screen, click Tools ➤ Display Drive Information.

2 Select the drive you want to view from the partition list. If you have more than one 
hard disk on your system, the first column in the partition list shows the physical disk 
where the partition is located.

Drive Information Displayed on the Screen (Partition Map)

Several Server Image dialog boxes include a partition map that shows the partitions on 
your hard disk. If the selected hard disk includes logical partitions, they are shown within 
an extended partition. Partitions are color coded to indicate the file system type each uses. 
For example, dark green indicates a FAT32 partition. In addition, each partition is shaded 
to show used and unused space within the partition.

The partition map also shows unallocated space (space not assigned to any partition).

There are triangle indicators on the partition map to mark the 2 GB boot code boundary 
and the 1024 cylinder limit. The boundary markers can help you as you restore image files 
or set a new partition active. If your operating system requires the boot code to be within 
the first 2 GB of the hard disk, for example, you can tell at a glance if the partition is 
located in a place that will make it bootable.

• Drive letters
• Volume (partition) labels
• Color-coded volume (partition) types
• Status (active partition)

• Partition size
• Used MB in partitions
• Free MB in partitions
• Primary or logical drive
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Creating Extended Partitions

If you create an image of a primary partition and want to restore it as a logical partition, 
you must first have an extended partition on your hard drive. For example, if you have two 
hard disks that each include a primary partition (a bootable C: and a data partition D:) and 
you are copying both partitions to a new hard disk that will be your master disk, you 
would want the D: partition copied to a logical partition to avoid having two primary 
partitions on the new hard disk. Primary partitions on the primary master drive should be 
reserved for operating systems only.

It is not necessary to manually create an extended partition when you restore an image of a 
logical partition. Server Image automatically creates an extended partition if one does not 
already exist.

1 At the Server Image main screen, click Tools ➤ Create Extended Partition.

The Create Extended Partition window appears.

2 Select an unallocated space from the partition list.

If there is no unallocated space on your computer, you must delete an existing 
partition to create unallocated space. 

3 Click Create.

Server Image creates an extended partition in the selected free space.

4 Click Close to return to the Server Image main screen.
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Deleting Partitions

This feature deletes existing partitions to create unallocated space on your hard drive. Be 
aware that deleting existing partitions destroys any data they contain.

1 At the Server Image main screen, click Tools ➤ Delete Disk Partition(s).

The Delete Partition(s) window appears.

2 Click the partition you wish to delete.

You may need to scroll to view all the partitions on your machine. Note that if you 
have more than one hard disk on your machine, the first column in the partition list 
shows the physical hard disk where the partition is located.

3 Click Delete, or to delete all partitions click Delete All.

The Delete Partition dialog appears, displaying the selected partition and its volume 
label.

4 Type the volume label exactly as it appears, then click OK. 

Server Image deletes the partition and displays the message: “Volume <volume 
name> was deleted successfully.”

5 Click Close to return to the Server Image main screen.
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Hiding Partitions

The Hide/Unhide feature allows you to protect partitions from unwanted user access. 
Hidden partitions are not accessible because they are not assigned drive letters when you 
boot your computer. If you unhide a partition, it is assigned a drive letter the next time you 
boot your computer and becomes accessible again.

Before hiding and unhiding partitions, be aware of the following restrictions.

• Hiding or unhiding a partition can cause the drive letters of subsequent partitions to 
change. This may make the computer fail to boot or cause applications to fail. For 
information on why drive letters change and how to fix them, run Setup from the 
Server Image CD, then click Documentation ➤ Basic Concepts.

• If your hard drive contains more than one primary partition, only one is visible by 
default. When you use the Set Active Partition feature, Server Image unhides the 
selected primary partition and automatically hides all other primary partitions. See 
“Setting the Active Partition” on page 32.

• Because a hidden partition is not bootable or accessible, if you hide the partition 
where Server Image is installed, you must re-install Server Image on your new active 
(bootable) partition to run it again.

To hide/unhide a partition,

1 At the Server Image main screen, click Tools ➤ Hide/Unhide Partition(s).

The Hide Partition(s) window appears.
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2 Click the partition you want to hide.

Normally when you select a partition, the Hide button becomes available. If the 
button is not available, the partition can’t be hidden.

3 Click Hide to hide the selected partition.

The partition status changes to “Hidden.”

4 Click a hidden partition. 

Normally when you select a partition, the Unhide button becomes available. If the 
button is not available, the partition can’t be unhidden.

5 Click Unhide to unhide the selected partition.

The partition status changes to “None.”

6 Click Close to return to the Server Image main screen.

7 Click Exit to exit Server Image.

8 Reboot your computer.

Setting the Active Partition

The Set Active Partition feature allows you to make a primary partition the active 
(bootable) partition. Only one primary partition can be active at a time. To be bootable 
under most operating systems, a primary partition must be located on the first (master) 
drive, and it must contain an operating system. When your computer boots, it scans the 
partition table of the first drive to find the active partition, then boots from that partition.

WARNING! Before you set an active partition, be sure it is bootable. If it is not bootable 
or if you are not sure, locate the boot disk you created when you installed 
Server Image. If you restart your computer and it does not boot normally, 
you must boot from the floppy disk, run Server Image from the program 
disk you created during Server Image install, and set a different partition 
active. Refer to “Drive Information Displayed on the Screen (Partition 
Map)” on page 28 for explanations of the Server Image screen that may also 
help you determine if your partition is bootable.

1 At the Server Image main screen, click Tools ➤ Set Active Partition.

The Set Active Partition window appears.
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2 Select a primary partition that is not currently active.

3 Click Set Active.

The status of the selected partition changes to “Active.”

4 Click Close.

5 Click Exit to exit Server Image.

6 Reboot your computer.
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C H A P T E R5
Automating Server Image
This chapter includes the following information:

• Command Line Switches

• Script Files
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Interactive Server Image vs. Scripting

Server Image may be run in one of two modes: interactive (the default) or scripting. 
Interactive mode requires user input at discrete intervals, resulting in greater control and 
efficiency when working with one or two servers. 

Alternately, scripting is useful when loading image files onto a large number of servers. 
Batch mode automates the loading process, saving you time and effort by eliminating the 
need for repetitive user input. 

Command Line Switches

Server Image uses a series of command line switches to run in batch mode. To use the 
these switches, type PQSINT /switch, where switch is one or more of the following:

Command Line 
Parameter

Description

/? Displays all available command line switches, their syntax, 
and a short description.

/IMG=<imagefilename> Designates an image file.

/CMD=<scriptfilename> Designates a script text file; the script file contains 
arguments that are passed to the program.

/LOG=<logfilename> Designates a log file.

/ERR=<errorfilename> Designates an error file.

/PWD=<password> Designates a password that must be given to restore the 
partitions. The password may either be a number or a string.

/CAS Causes all sectors within a partition to be saved and 
restored. This will include all information in a partition 
including the deleted files.

/CBS Enables bad sector checking.

/CEC Check for extra cylinder.

/DSK Specify disk number for macro commands.
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Command Line Examples

Scenario 1: To specify SCRIPT.TXT as the script file, ERROR.TXT as the error file, and 
E:\IMAGES\DRIVE2.PQI as the image file:

PQSINT /CMD=SCRIPT.TXT /ERR=ERROR.TXT /IMG=E:\IMAGES\DRIVE2.PQI

/IFC Ignores file system checks. This allows a partition with a 
known file system error (for example, cross-linked files) to 
be stored in an image. Likewise, that same partition can be 
restored if this switch is used and if during the restore 
process the partition does not need to be resized.

/IPE Disables partition table error checking. This switch allows 
drives with partition errors to be saved and restored.

/MFS=nnnnn Designates the maximum file size used for creating multiple 
files to contain a PQI image. (nnnnn is the number of bytes 
in each file).

/NBS Disables bad sector checking. By default, bad sector 
checking is disabled.

/NRB No reboot after program exit.

/RAV Causes each sector written to disk during the restore process 
to be read back and compared with the data just written as an 
extra security precaution. Using this parameter will 
significantly increase restore time.

/SCO Syntax Check Only parameter; this switch causes the syntax 
of each command in the script file to be checked without 
executing the command.

/UEB Forces the extended BIOS to be used for disk reads and 
writes.

/WFS Wipe First Sector parameter; deletes the master boot record 
once all partitions are deleted with the script command 
DELETE ALL; only accessible using scripting.

/ZLB Use ZLib compression.

Command Line 
Parameter

Description
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Scenario 2: To specify a syntax check for the script file SCRIPT.TXT:

PQSINT /CMD=SCRIPT.TXT /SCO

Script Files

The script file designated in the command line contains arguments or instructions that are 
passed to the program, determining which operations are executed. The script file syntax 
is as follows:

Script Argument Action

DELETE Deletes the last partition selected.

DELETE ALL Deletes all partitions on the drive.

DELETE EXTENDED Deletes the extended partition; the extended 
partition can only be deleted if all the logical 
drives within it have already been deleted.

HIDE Hides the last partition selected.

REBOOT Reboots the computer; any commands 
following this command will not be executed.

RESIZE IMAGE
{proportional | no | <number> | 
max}

Resizes the image to the specified size when 
restored; <number> is indicated in MB.

RESTORE Restores all selected images and resizes them, 
if specified.

SECTOR CHECK {on | off} Enables/Disables Bad Sector Checking for all 
restore operations following the command.

SELECT DRIVE {<number>} Selects the drive with the specified number; the 
first drive is number 1.

SELECT FREESPACE
{first | last | next | largest}

Selects the specified free space.

SELECT IMAGE {<number> | all} Selects the specified image in the image file.

SELECT PARTITION 
{<driveletter> | <volumelabel> | 
<number> | first |next | all}

Selects the specified partitions.

SET ACTIVE Sets active the last partition selected.



PowerQuest Server Image for Windows NT 39

Script File Examples

Scenario 1: To store all the partitions on drive 2 to the file, E:\IMAGES\DRIVE2.PQI:

PQSINT /CMD=SCRIPT.TXT /IMG=E:\IMAGES\DRIVE2.PQI

SCRIPT.TXT file contents:

SELECT DRIVE 2
SELECT PARTITION ALL
STORE

Scenario 2: To store partition 3 from drive 1, and partitions 1, 4, and 5 from drive 2 to the 
file, E:\IMAGES\DRIVE.PQI and have the image file split up into multiple files each 650 
MB so each can be transferred to a CD-ROM:

PQSINT /CMD=SCRPT.TXT /IMG=E:\IMAGES\DRIVE.PQI /MFS=670000000

SCRPT.TXT file contents:

SELECT DRIVE 1
SELECT PARTITION 3
STORE
SELECT DRIVE 2
SELECT PARTITION 1
SELECT PARTITION 4
SELECT PARTITION 5
STORE

Scenario 3: To restore all the images in the file, E:\IMAGES\DRIVES.PQI, to the first 
free space on drive 2:

PQSINT /CMD=SCRIPT.TXT /IMG=E:\IMAGES\DRIVES.PQI

SCRIPT.TXT file contents:

SELECT DRIVE 2
SELECT FREESPACE FIRST
SELECT IMAGE ALL
RESTORE

STORE
{with compression {off | low | high}}

Stores all selected partitions with the indicated 
compression level.

UNHIDE Unhides the last partition selected.

Script Argument Action
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Scenario 4: To restore the first two images in the file, E:\IMAGES\DRIVES.PQI, to the 
largest free space on drive 1, and resize them both proportionally:

PQSINT /CMD=SCRIPT.TXT /IMG=E:\IMAGES\DRIVES.PQI

SCRIPT.TXT file contents:

SELECT DRIVE 1
SELECT FREESPACE LARGEST
SELECT IMAGE 1
SELECT IMAGE 2
RESIZE IMAGE PROPORTIONAL
RESTORE

Scenario 5: To restore the first two images in the file, E:\IMAGES\DRIVE.PQI, to the last 
free space on drive 1, and resize them to 500 MB each (The image was encrypted using the 
password 12345678):

PQSINT /CMD=SCRPT.TXT /IMG=E:\IMAGES\DRIVE.PQI /PWD=12345678

SCRPT.TXT file contents:

SELECT DRIVE 1
SELECT FREESPACE LAST
SELECT IMAGE 1
RESIZE IMAGE 500
SELECT IMAGE 2
RESIZE IMAGE 500
RESTORE

Scenario 6: To delete all existing partitions on drive 2 and then restore all the images in 
file, E:\IMAGES\DRIVES.PQI, to the free space (The image was encrypted using the 
password HELLO):

PQSI /CMD=SCRIPT.TXT /IMG=E:\IMAGES\DRIVES.PQI /PWD=HELLO

SCRIPT.TXT file contents:

SELECT DRIVE 2
DELETE ALL
SELECT FREESPACE FIRST
SELECT IMAGE ALL
RESTORE
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Scenario 7: To restore the first four images in the file, drive:\IMAGES\DRIVES.PQI, to 
the last free space on drive 1, and then resize the first image to 500 MB, keep the second 
the same size, and resize the third and fourth images to proportionally take up the 
remaining free space:

PQSI /CMD=SCRIPT.TXT /IMG=drive:\IMAGES\DRIVES.PQI

SCRIPT.TXT file contents:

SELECT DRIVE 1
SELECT FREESPACE LAST
SELECT IMAGE 1
RESIZE IMAGE 500
SELECT IMAGE 2
RESIZE IMAGE NO
SELECT IMAGE 3
SELECT IMAGE 4
RESIZE IMAGE PROPORTIONAL
RESTORE

For further Server Image scenarios, visit www.powerquest.com.
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A P P E N D I XA
Additional Tasks
This appendix includes the following information: 

• Using Server Image with SCSI Hard Disks

• Using International Keyboards

• Finding Jumper Settings
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Using Server Image with SCSI Hard Disks

To use Server Image on a SCSI hard drive, you must have a SCSI controller card that 
supports software Interrupt 13. Most SCSI controller cards let the user enable software 
Interrupt 13 support in the BIOS through the card. If your SCSI controller card does not 
allow you to set it to use software Interrupt 13, Server Image will not work on drives 
attached to your SCSI adapter. Contact the manufacturer of the SCSI adapter to determine 
if your adapter can support software Interrupt 13. As a general rule, if FDISK can be used 
to partition the drive, you can use Server Image.

Using International Keyboards

When you use the Server Image rescue disks, you may lose the ability to use your 
keyboard the way you are accustomed to or to view extended characters properly. The 
Server Image rescue disks include the files you need to resolve these problems.

If you use an international keyboard or character set, you must edit the AUTOEXE2.BAT 
and CONFIG.SYS files on the rescue disks.

1 The following lines are remarked in the AUTOEXE2.BAT file. Delete the REM from 
the beginning of the line, and replace the variables xx and yyy with the keyboard 
code and character set code page for your language.

MODE CON CP PREP=((yyy)EGA.CPI)
MODE CON CP SEL=yyy
KEYB xx,yyy

xx = two-letter keyboard code (for example, US or FR)
yyy = character set code page (for example, 437)

2 Save the AUTOEXE2.BAT file.

3 The following line is remarked in the CONFIG.SYS file. Delete the REM from the 
beginning of the line, and replace the variable yyy with the character set code page 
for your language.

DEVICE=DISPLAY.SYS CON=(EGA,yyy,)

4 Save the CONFIG.SYS file.

5 Reboot from the first rescue disk.
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Finding Jumper Settings

To find the jumper settings for hard disks, consult your hard disk installation guide or 
contact your hard disk manufacturer directly. In most cases, the hard disk manufacturer's 
web site will contain the information you need to install the hard disk correctly.

Another valuable resource is www.thetechpage.com. In addition to listing the most 
common hard disk manufacturers, this site provides the jumper settings for every hard disk 
ever made. Additional jumper information is available from OnTrack at www.ontrack.com. 
Please note that PowerQuest is not responsible for the content on these web sites and 
cannot guarantee that the web site addresses will not change.
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A P P E N D I XB
Troubleshooting
This appendix gives solutions to problems that you may encounter 
while using Server Image. Included are the following:

• Accessing Your CD-ROM Drive

• Freeing Conventional Memory to Run Server Image

• Resolving Check Errors

• Resolving Check Errors

• Resolving Partition Table Errors

• Partition Tables and Viruses

• Generating Diagnostic Reports with PARTINFO

• Error Messages and Solutions
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Accessing Your CD-ROM Drive

If you need to access your CD-ROM drive from Server Image, you will need to add the 
command in the CONFIG.SYS file to load your CD-ROM driver. You will also need to 
add the command in the AUTOEXEC.BAT file to load the CD-ROM extensions.

1 At the DOS prompt, change to the directory of the CONFIG.SYS you want to edit. 
For example, if you are editing the CONFIG.SYS on a boot diskette, type drive: 
(where drive is the drive letter of the boot diskette), then press <Enter>.

2 Type EDIT CONFIG.SYS and press <Enter> to start the DOS Editor and retrieve 
the CONFIG.SYS file.

3 Add either the DEVICE or DEVICEHIGH command. For example, type

DEVICE=[drive:][path]filename [dd-parameters]

or

DEVICEHIGH=[drive:][path]filename [dd-parameters]

where [drive:][path]filename specifies the location and name of the CD-ROM device 
driver and [dd-parameters] specifies any command-line information the device driver 
requires.

You may want to use DEVICEHIGH if you need to conserve conventional memory. See 
“Freeing Conventional Memory to Run Server Image” on page 49.

For more information on your device driver, consult the documentation that came 
with your CD-ROM.

4 Click File ➤ Save to save the file.

5 Click File ➤ Open and retrieve the AUTOEXEC.BAT file.

6 Add the command line MSCDEX.EXE.

7 Click File ➤ Save to save the file.

8 Click File ➤ Exit to exit the editor.
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Freeing Conventional Memory to Run Server Image

The Server Image executable running under DOS requires a minimum of 400KB of 
memory in the first 640KB of the computer's address space (conventional memory). If you 
try to run Server Image from DOS and find you do not have enough free conventional 
memory, you can free enough additional memory in a number of ways.

Running MEMMAKER

MEMMAKER is a program that automatically configures your computer to save 
conventional memory (while still loading all of the device drivers and other programs you 
usually load when booting DOS). MEMMAKER frees conventional memory by moving 
as many programs as possible out of conventional memory into high memory. Run 
MEMMAKER by typing MEMMAKER at a DOS prompt. Follow the on-screen 
instructions.

MEMMAKER is only available with DOS versions prior to DOS 6.0. MEMMAKER is 
not available with Windows 95.

Using the F8 Key to Keep Programs From Loading

If running MEMMAKER does not free enough conventional memory, you can free more 
by pressing <F8> right after booting your computer (while DOS is booting). If you press 
<F8>, when DOS reads the commands from the CONFIG.SYS and AUTOEXEC.BAT 
files on your hard drive, DOS will ask you if you want it to execute each command. When 
you see commands that load device drivers or TSR programs that you will not need to run 
Server Image, answer N (no) to tell DOS not to execute that command (not load that 
software into memory). This will conserve conventional memory. 

Creating an Operating System Boot Diskette

If running MEMMAKER and using <F8> does not free enough conventional memory, you 
can create a boot diskette that allows you to boot using a very minimal amount of 
conventional memory.

You can create a boot diskette for any version of DOS by performing the following:

1 Place in your diskette drive (A:) any diskette that does not contain information you 
want to keep. 

2 Go to a DOS prompt, type FORMAT drive: /S (where drive is the drive letter of 
the diskette drive).

3 Press <Enter>.
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After the diskette is formatted and the operating system files are transferred, you will be 
able to boot the computer from the diskette. If you restart your computer with the diskette 
in the diskette drive, your computer boots using a minimal amount of conventional 
memory. After you boot from the diskette, you can run Server Image from either the 
diskette or your hard drive. 

If you want to create and restore images across a network, you will need to create a 
network boot diskette.

Creating a CONFIG.SYS File on the Boot Diskette

If making an ordinary boot diskette doesn't free enough conventional memory, you can 
create a customized boot diskette that will free even more conventional memory. (With the 
customized diskette, you will free more conventional memory by loading some of the 
DOS operating system into high memory.) To customize the diskette, you must create a 
CONFIG.SYS file in the root directory (A:\). To create a CONFIG.SYS in the root 
directory, perform the following:

1 At the DOS prompt, type drive: (where drive is the drive letter of the diskette 
drive), then press <Enter>. 

Verify that you have changed to the diskette drive (you see the drive:\> prompt).

2 Type EDIT CONFIG.SYS and press <Enter>. 

This starts the DOS editor. (You will see a blank screen if no CONFIG.SYS currently 
exists.)

3 In the editor, type the following:

DEVICE=C:\DOS\HIMEM.SYS

DEVICE=EMM386.EXE

DOS=HIGH,UMB

IMPORTANT! All lines must be entered in the order shown. Windows users: 
substitute DEVICE=C:\WINDOWS\HIMEM.SYS.

4 Click File ➤  Save to save the file. 

5 Click File ➤ Exit to exit the editor.

You can now reboot your computer from the customized boot diskette. When DOS loads, 
much of it is loaded into high memory, saving a maximum amount of conventional 
memory.
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Deleting Operating System Compression Files

If you use DOS 6.22 and your system doesn't have any compressed drives (for example, 
DriveSpace, DoubleSpace, or Stacker), you can free conventional memory by deleting the 
operating system compression files DRVSPACE.BIN or DBLSPACE.BIN from any boot 
diskette you create. To delete these hidden system files, perform the following:

1 From the DOS prompt, type drive: (where drive is the drive letter of the diskette 
drive).

2 Type ATTRIB -R -H -S *.BIN.

3 Type DEL *.BIN.

Resolving Check Errors

Server Image checks the integrity of a partition very thoroughly prior to creating an image 
file or copying a partition. These checks are substantially the same as those made by the 
operating system's CHKDSK, SCANDISK, or AUTOCHK utility.

If you receive a Check error message for any partition, after backing up your hard drive, 
run your operating system's CHKDSK program on that partition. CHKDSK usually shows 
the same problems as Server Image. (If you are using Windows NT CHKDSK, DO NOT 
use the /F switch on the initial run.)

The DOS CHKDSK program does not detect problems in Extended Attributes.

If CHKDSK (or SCANDISK) does not show the same errors that Server Image shows, 
contact PowerQuest at the numbers listed in Appendix D. If the CHKDSK (or 
SCANDISK) program and Server Image detect the same errors (which is usually the 
case), run CHKDSK with the /F switch to fix the problem. 

After running CHKDSK /F, run CHKDSK without the /F switch to make sure the partition 
is free of errors. Under OS/2, you should perform this procedure twice before proceeding. 
If Server Image still reports a problem, reformat the partition and restore your files from 
the backup copy to correct the error.

Server Image also checks a partition after restoring it. If this check fails, report the 
problem to PowerQuest Technical Support. The problem is usually a minor file system 
error that CHKDSK /F can correct without data loss. For more extensive errors, you may 
need to restore your files from a backup copy.
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Resolving Partition Table Errors

In some cases, PowerQuest technical support can help you fix partition table errors 
without data loss. Check with them first before proceeding to the following steps.

To resolve some partition table errors, you must create new, error-free partition tables.

1 Make sure you have no viruses. 

See “Partition Tables and Viruses” on page 52.

2 Back up the data on the affected partitions.

3 Delete the partitions.

You may need to use the FDISK program from a recent DOS version because earlier 
versions of DOS may refuse to delete HPFS or hidden partitions.

If using OS/2, the OS/2 FDISK program may recognize the partition's corruption and 
refuse to modify it. In this case, use the FDISK program from a recent DOS version.

4 Recreate the partitions.

5 Restore the contents of the partitions. 

Partition Tables and Viruses

If partition changes made under one operating system are not reflected under the other, 
and vice versa, it is possible that a master boot record (MBR) virus is present.

Use a virus check utility that can detect the latest viruses. If a virus is found, data loss is 
likely. If a virus is found, perform the following:

1 Before removing the virus, run ScanDisk or CHKDSK under each of the operating 
systems to evaluate the integrity of the partition. 

2 Back up the files from any partition that passes the Check operation.

3 After backing up the files from all operating systems, remove the virus.

4 Run ScanDisk or CHKDSK under each of the operating systems again.

5 Delete and recreate any partitions which fail the check. 

6 Reinstall the operating systems.
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7 Restore the backup files as necessary.

Generating Diagnostic Reports with PARTINFO

PARTINFO, a PowerQuest utility program included on the Server Image CD, generates a 
report showing the contents of your hard disk partition table. This information is helpful in 
resolving various partitioning problems. 

1 Boot the computer to DOS.

2 Change to the directory that includes PARTINFO.EXE.

3 You have several options for running PARTINFO. 

PowerQuest support technicians may request a report from PARTINFO to help you 
resolve any problems that you experience with Server Image.

Error Messages and Solutions

For a list of error messages and solutions in English, you can also go to the PowerQuest 
Knowledge Base at www.powerquest.com/support/er/err-0000.html.

Miscellaneous Errors (3–38)

#3 Not enough memory 

The DOS Server Image executable running under DOS requires a minimum of 
400KB of memory in the first 640KB of the computer's address space 
(conventional memory) and 8MB of total memory. If you don't have enough 
conventional memory, see “Freeing Conventional Memory to Run Server Image” 
on page 49 for possible solutions.

To do this: Do this:

To display partition 
information on your screen

Type PARTINFO, then press <Enter>.

To send a report directly to 
your printer

Type PARTINFO >LPT1 or PARTINFO 
>PRN, then press <Enter>.

To save the report as a text file 
on a floppy disk

Type PARTINFO >A:\PARTINFO.TXT, then 
press <Enter>.
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The boot diskette (disk 1 of 2 Server Image rescue disks) includes EMM386.EXE 
to help load network drivers in high memory. However, because this file limits 
extended memory to 32 MB, you may see error #3 when you run Server Image 
from the rescue disks and work with large FAT32 and NTFS partitions. If you do 
not need EMM386.EXE, you can delete it from the bootable floppy to avoid this 
error. If you delete the EMM386.EXE file, you must also REM or delete the 
following line in the CONFIG.SYS file on the boot floppy: 
DEVICE=EMM386.EXE.

#8 Could not allocate/deallocate DOS real mode memory 

The DOS Server Image executable running under DOS requires some memory in 
the first 1 MB of the computer's address space. (Server Image uses a DOS 
extender.) If not enough memory is available, Server Image cannot access the 
hard drive. If you don't have enough conventional memory, see “Freeing 
Conventional Memory to Run Server Image” on page 49 for possible solutions.

#23 Unsupported version of operating system

The operating system versions that are required to run Server Image are listed on 
page 1.

#34 This beta or evaluation version is no longer safe to use

PowerQuest occasionally releases beta versions and evaluation versions of Server 
Image. Both versions are not as safe as released versions; therefore, PowerQuest 
builds an expiration date into each version. After a predetermined test period, the 
beta or evaluation version will no longer function. 

#36 DPMI Server error

Server Image DOS executables use a DOS extender. This error indicates a failure 
during a call made from Server Image through the DOS extender (to DOS or to 
the BIOS). The DOS extender may be in conflict with other programs that use 
extended memory. DOS would load the conflicting programs from your 
CONFIG.SYS or AUTOEXEC.BAT file during the normal boot sequence.

You may be able to resolve this problem by pressing <F8> while booting DOS. 
After DOS boots and starts to read the commands from your CONFIG.SYS and 
AUTOEXEC.BAT files, DOS will ask if you want to execute each command. 
When you see commands that load device drivers or TSR programs that you 
think might be conflicting with the Server Image DOS extender, answer N (no) to 
tell DOS not to execute that command (not to load that software into memory). 
You will often be able to find a program configuration that will enable Server 
Image (the DOS extender) to run without error.
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Disk Access Errors (40–56)

Errors 40-56 indicate that Server Image cannot access your hard disk; these errors are 
often reflect hardware problems. Some problems have simple solutions; for other 
problems, the only solution is to replace the hard drive. When possible, Server Image 
detects errors before any changes have been made, so you can back up your data before 
replacing the hard drive.

#49 Write fault 
#50 Read fault 

Server Image is unable to read or write from a specific sector on the hard drive. 
There are a number of possible causes of this error:

• If your PC beeps or displays a black box in the middle of the screen, virus 
protection is enabled in your computer's BIOS. Disable virus or boot sector 
protection in the BIOS.

• A virus protection application (which may be a TSR or DLL program) is in 
use. Disable the application before using Server Image.

• There is a bad sector on the hard drive. (This is usually the case with only older 
hard drives.) Run a thorough ScanDisk on the hard drive to perform a surface 
scan to verify the existence of bad sectors. If your drive has bad sectors, we 
recommend you replace it. You may be able to use Server Image, or you may 
need to back up your files using another method.

• You have set up disk mirroring with PC-Tools. Disable disk mirroring.

• Your caching controller card is not set up properly.

Partition Table Errors (100–199)

Errors in the 100-199 number range are partition table errors. For general information 
about solving this type of error, see “Resolving Partition Table Errors” on page 52.

#100 Partition table is bad

The master boot record (MBR) can contain, at most, one extended partition, and 
each extended partition boot record (EPBR) can contain, at most, one link to 
another EPBR. This error occurs when a partition table violates the foregoing 
rule. Since any modifications Server Image makes may decrease the amount of 
data that is recoverable from the hard drive, Server Image will not recognize any 
of the hard drive's partitions. You must create new, error-free partition tables to 
resolve your problem. See “Partition Tables and Viruses” on page 52.
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#104 No sectors in partition

No partition should contain zero sectors. Delete the partition before using Server 
Image. 

#105 Partition starts on wrong boundary

The hard-disk partition table contains erroneous values. Server Image expects 
FAT, NTFS, and HPFS partitions to begin and end on the boundaries used by 
FDISK. If they do not, the disk may be partially corrupted. In this circumstance, 
if Server Image were to make any modifications it might cause the loss of data. 
Therefore, Server Image will refuse to recognize any of the hard drive's 
partitions. To resolve this problem, see “Resolving Partition Table Errors” on 
page 52.

#106 Partition doesn't start with sector one

See error #105.

#107 Partition begins after end of disk

This error can occur when you are running Server Image on a hard drive that uses 
more than 1,024 cylinders. Under DOS, Server Image is restricted by the BIOS 
1,024 cylinder limit. If any partitions extend beyond the limit, Server Image 
cannot safely operate on the hard drive.

This error can also occur if a partition erroneously extends beyond the physical 
end of the hard drive. This may happen if the hard drive has been used on a 
different computer or with a different hard-disk controller or if BIOS settings 
have been changed. Be advised that the physical geometry of the hard drive may 
differ from the logical geometry assigned to the hard drive by the operating 
system.

#108 Partition doesn't end at end of cylinder

See error #105.

#109 Partition ends after end of disk

See error #107.

#110 Partition table number of sectors is inconsistent

The hard-disk partition table contains two inconsistent descriptions of the number 
of sectors on the hard drive. This error is serious if both DOS and another 
operating system use the hard drive. Because DOS uses one description and other 
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operating systems may use the other, data loss is likely once the partition is 
almost full. To resolve this error, see “Resolving Partition Table Errors” on page 
52.

#111 Logical partition starts outside Extended

The hard-disk partition table contains erroneous values. All logical partitions 
must be totally contained within the extended partition. To resolve this error, see 
“Resolving Partition Table Errors” on page 52.

#112 Logical partition ends outside Extended

See error #111. 

#113 Partitions overlap

The hard-disk partition table contains erroneous values. If data partitions overlap, 
writing to one may destroy data in another.

This error is sometimes the result of an OS/2 FDISK bug. If free space exists 
within the extended partition, OS/2's FDISK program allows a primary partition 
to be created that overlaps the extended partition. A logical partition is 
subsequently created in the space occupied by the overlapping primary partition. 

If a primary partition overlaps the end of the extended partition, but does not 
overlap any logical partitions within the extended partition, the problem can be 
remedied by patching the partition table. Only qualified individuals should 
attempt this repair! An incorrect patch could destroy all data on the hard drive! In 
most instances, you should resolve the problem as explained in “Resolving 
Partition Table Errors” on page 52.

#116 Partition table Begin and Start inconsistent

The hard-disk partition table contains two inconsistent descriptions of the 
partition's starting sector. This error can occur if the operating system reports a 
hard-disk geometry that is different than the geometry in use when the partition 
table was written. Possible causes of the hard-disk geometry changing are: 

• Different operating systems (for example, DOS and OS/2) report different 
hard-disk geometries.

• You boot from a diskette that loads a different driver than is loaded when you 
boot from the hard drive.

• Upgrading the operating system (for example, from OS/2 2.x to OS/2 Warp) 
causes a different driver to be used.

• The hard drive or controller has been changed.
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• The BIOS has been upgraded.

• The BIOS LBA setting has been changed.

• There is a partition table virus present on the hard drive.

In most instances, you should resolve the problem as explained in “Resolving 
Partition Table Errors” on page 52. You can also use a virus scanning program to 
remove any partition table virus. Data loss is possible if the number of heads or 
sectors per track has changed since you first created your partitions.

#120 The logical drive chain is incompatible

This error occurs under some OSs when logical partitions are not chained 
together in the expected order. DOS, OS/2, Windows 95, and Windows NT 
require that logical partitions be chained together in ascending order. Some other 
operating systems do not require this. For example, some versions of the Linux 
FDISK utility chain logical partitions together in the order they are created.

WARNING! This error message identifies a dangerous situation; using the DOS 
FDISK in this situation can cause loss of one or more partitions. 

For solutions to this problem, see the instructions in “Resolving Partition Table 
Errors” on page 52. 

If you decide to back up your data and recreate your partitions, you may have to 
use the same partitioning program that you used to create the partitions to delete 
them.

#121 The first sector of the drive cannot be read

The first sector of the hard drive (cylinder 0, head 0, sector 1) contains the master 
boot record (MBR) and the primary partition table. Server Image cannot make 
changes to this hard drive because an error occurred when it read the first sector. 
See error #50 for information on resolving this error.

#122 A bad sector was found in the current or new partition area

The partition cannot be moved safely because there is a bad sector in the new or 
current partition area. When you see this error message, the move operation will 
be aborted before any corruption can occur. Try moving the partition to a 
different place. If your hard drive has bad sectors, we recommend that you 
replace the hard drive.
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Check Errors (500–599)

Check errors occur when Server Image checks the integrity of a partition. For useful 
general information about resolving these errors, see “Resolving Check Errors” on page 
51.

#500 Subdirectory is corrupted

This error message reveals the name of the corrupted subdirectory. Back up the 
contents of that directory and its subdirectories. You can then delete the corrupted 
subdirectory.

#501 Cross-linked files were found

ScanDisk or CHKDSK should be able to find these errors and correct them.

#506 Not enough free space on partition to shrink

Some free space (which is dependent on the hard drive's current contents) is 
required to resize a partition smaller. Delete unneeded and duplicate files in the 
partition, then attempt the operation again.

#508 As specified, the operation does not change the partition

You have entered a value that is the same as or (when rounded to the required 
cylinder boundary) rounds to the same as the partition's present value. Enter a 
larger change.

#509 A bad sector was detected in the current or new FS area

In order to perform the resize operation that you requested, Server Image 
attempted to expand the file system area. However, the program found a bad 
sector in the new area. Try moving the partition before you resize it. No 
corruption will occur when you encounter this error.

#510 The version of the file system is not supported

An updated version of Server Image is required to operate on this new version of 
the file system. Visit www.powerquest.com/updates for information about 
updated versions of Server Image.

HPFS Check Errors (1000–1500)

Check errors occur when Server Image checks the integrity of a partition. For useful 
general information about resolving these errors, see “Resolving Check Errors” on page 
51.

http://www.powerquest.com/updates
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#1015 System sector not marked unavailable

This error may indicate that there are open files on the hard drive. Shut down and 
restart OS/2, booting from diskettes. If this does not resolve the problem, run 
OS/2's CHKDSK program. This error message may also indicate that a file is 
listed with a file length of zero. OS/2's CHKDSK program will not fix this 
problem. As a last resort, delete the offending file.

#1027 Could not account for all sectors

This error may be resolved in one or more of the following ways:

• If you are working with an HPFS386 partition, check the technical support area 
of PowerQuest's web site (www.powerquest.com/support) for more 
information.

• If CHKDSK has created any FOUND.000 or *.CHK files, delete them.

• If the error message indicates the name of the offending file, delete it.

• Turn off the disk-mirroring option in PC-Tools.

• If none of the above solutions works, back up the partition, delete it, recreate it, 
and restore the data.

#1045 Stac volume detected delete—Stac volume before converting

This error message occurs when you attempt to convert a partition to HPFS, and 
the existing partition contains a STAC volume. Stacker cannot access a STAC 
volume that is on an HPFS partition. Delete the STAC volume from the partition 
before converting to HPFS.

NTFS Check Errors (1500–1699)

Errors 1500-1699 are NTFS-specific error messages. In this context, “attribute” does not 
mean read-only, hidden, system, and so on. Rather, “attribute” means one of a file’s data 
streams. Check errors occur when Server Image checks the integrity of a partition. For 
useful general information about resolving these errors, see “Resolving Check Errors” on 
page 51.

#1501 Wrong version of NTFS

The partition was created using a version of the NTFS file format that Server 
Image cannot work with.

#1503 Bad NTFS cluster size

The NTFS cluster size must be 512, 1,024, 2,048, or 4,096 bytes.

http://www.powerquest.com/support
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#1512 Restart record mismatch

The two restart entries in the journal file are different. This may happen if 
Windows NT is not properly shut down. To fix this problem, restart Windows NT 
and shut it down using the Shut Down command.

#1516 Partition improperly dismounted

The partition dirty flag is set in a restart record in the journal file. This error may 
have been caused by a power failure or system crash while the Windows NT 
operating system was writing the partition. Reboot Windows NT and execute 
CHKDSK /F to repair the damage.

#1527 Bad update sequence number

A buffer contains mismatched update sequence numbers. This error may have 
been caused by a power failure or system crash while the Windows NT operating 
system was writing to the partition. Reboot Windows NT and execute CHKDSK 
/F to repair the damage.

#1529 Information mismatch in directory entry

A file attribute stored in a file record is different from the attribute stored in its 
directory entry. If this error is in a system file (file 0-10), Windows NT's 
CHKDSK program will not fix it, but Windows NT will rebuild the root directory 
on the partition the next time the operating system is started.

#1538 Can't find contiguous space to move

The partition does not contain enough contiguous free space to hold the new copy 
of a file that must be contiguous. You will normally encounter this error when 
you use the Resize option to resize a partition smaller.

#1539 File size mismatch

The size of a system file (file 0-10) recorded in its file record does not match 
either the size recorded in its directory entry in the root directory or the size of its 
data stream.

#1544 External attribute list in external attribute

An external file record has an external attribute list.

#1545 File attributes out of order

The attributes in a file must appear in order of increasing numeric type.
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#1546 Attribute neither resident nor nonresident

The attribute resident flag has a value other than resident or nonresident.

#1547 Wrong run limits

A run has more clusters than the difference between its highest and lowest 
cluster.

#1548 File table has fewer than 16 entries

The file table must have at least 16 entries.

#1549 File table has more than 4 billion entries

The file table must have fewer than 4 billion entries.

#1644 Bad system file sequence number

A system file has a bad sequence number. System files must have a sequence 
number from 0 to 10. A partition with this problem may pass a run of Windows 
NT's CHKDSK program, but Windows NT will not mount the partition the next 
time the operating system is started.

#1647 Error in root directory index

There is an error in the root directory's index. Running Windows NT's CHKDSK 
program will not fix this problem, but the Windows NT operating system will 
automatically rebuild the root directory on the partition the next time it is started.

#1654 File system smaller than partition

This is an informational message only that indicates there may be wasted space 
on your hard disk. However, your data is not in danger, and you do not need to do 
anything to correct the error.

Miscellaneous Server Image Error Messages

#1701 Err disk not empty 

Used in scripting. The DELETE ALL command failed to delete all the partitions 
on the drive.

#1800 Err partition not open

Attempted operation on a partition in an improperly opened image file.

#1801 Err partition not found

Did not find requested partition in image file.
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#1802 Err corrupt bundle

Image file header information is not valid.

#1803 Err bundle read only

Attempted to delete or write to a partition in the image file which was opened in 
Read Only mode.

#1804 Err no bitmap Image

File contains no partition bitmap.

#1805 Err write failed 

Error encountered while writing image to file. This error usually occurs when 
Server Image runs out of space in the partition to which it is writing an image file.

#1806 Err out of memory

Out of Memory.

#1807 Err compression

Error encountered while compressing or decompressing image file data.

#1808 Err buffer too small

Buffer too small to read in partition bitmap.

#1809 Err no more free space

No more free space available to process remaining partitions.

#1810 Err open failed

Could not open image file.

#1811 Err read failed

Could not read from image file.

#1900 Err invalid drive number

Used in scripting. The script contains an invalid drive number.

FAT Check Errors (2000–2099)

Check errors occur when Server Image checks the integrity of a partition. For useful 
general information about resolving these errors, see “Resolving Check Errors” on page 
51.
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#2001 FAT copies are not identical

Run SCANDISK to fix this error. This problem may also be caused by a virus. 
Run a virus checker and remove the virus if possible.

#2005 One or more lost clusters were found

Run ScanDisk or CHKDSK to fix this error. 

#2012 Formatted FAT file system too big for partition

This error can be caused by the following circumstances:

• The number of sectors in the partition is larger than 65,536, and the 
bsHugeSects field of the boot sector (“Big total number of sectors” in Norton's 
DISKEDIT utility) shows that there are more sectors in the partition than the 
partition table shows.

• The number of sectors in the partition is less than 65,536, and the bsSects field 
of the boot sector (“Total sectors on disk” in Norton's DISKEDIT utility) 
shows that there are more sectors in the partition than the partition table shows.

This situation can result in data loss when the FAT file system tries to use space 
outside the partition that does not exist or that belongs to another partition. Since 
file data may exist outside the partition boundary, you cannot fix the problem by 
simply patching the boot sector.

To correct the error, back up all data on the partition, delete the partition, recreate 
the partition, and restore the data. Alternately, it has been reported that you can 
use Norton Disk Doctor to fix this problem.

#2013 A component of FAT geometry is bad

This error can be caused by the following circumstances:

• The number of clusters on the hard drive is greater than the FAT limits allow. 
This can result from bad values in the boot sector for the number of sectors, 
FATs, root entries, reserved sectors, and sectors per cluster.

• The number of sectors in the FAT is not large enough to hold the number of 
clusters present on the hard drive.

A qualified consultant may be able to fix the hard drive by performing simple 
patches. Alternately, you can back up the data on the partition, delete the 
partition, recreate the partition, and restore the files.
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#2024 The OS/2 Extended Attribute file is corrupt

This error is caused by any program that mistakenly writes to or overwrites the OS/2 
Extended Attribute file. If this error occurs, you should back up your data, delete the 
partition, recreate the partition, and restore your data.
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A P P E N D I XC
PowerQuest Technical Support
This appendix includes the following information:

• Before Contacting Technical Support

• Term of Technical Support

• Contact Information
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Before Contacting Technical Support

Before contacting PowerQuest, please try to resolve problems you encounter by using the 
online Help, the user guide, the README file, and PowerQuest's corporate web site.

Tips
• Your problem may be resolved by applying the most recent patch or upgrade of the 

software.

• Your product serial number is required to obtain technical support.

• If you received a demo or trial version of the product, you are not entitled to 
complimentary technical support.

Term of Technical Support

Technical support is available to all registered users throughout the life of the product, 
which began when PowerQuest released the software to manufacturing and ends six 
months after the release of the next version of the software or when PowerQuest 
discontinues its development.

Upon registration, PowerQuest provides 45 days of complimentary technical support from 
the day of your first call.

Contact Information

Corporate Web Site

The Technical support web site, support.powerquest.com, includes an overview of support 
options, an e-mail support request form, a list of error messages and information to resolve 
problems you encounter, and answers to frequently asked questions about the product.
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E-mail

To obtain e-mail technical support for specific technical questions, you can fill out the 
form at www.powerquest.com/support/emsupport.html (available in English only).

E-mail on Demand

PowerQuest maintains an e-mail on demand system to resolve common problems. You can 
view a list of available documents at support.powerquest.com. To request one of the 
documents, send an e-mail message to support@powerquest.com with the index number 
of the document in the subject of the message. You can only request one document per 
e-mail message. E-mail on demand documents are available only in English.

Fax

Fax a description of your problem to the technical support fax number. This service is 
available in the U.S., Canada, and Europe 24 hours a day, 7 days a week. PowerQuest 
technicians try to respond to all fax requests within 24 hours.

Language
E-mail (for specific 
technical problems)

Dutch eurots@powerquest.com

English help@powerquest.com
eurots@powerquest.com

French france@powerquest.com

German germany@powerquest.com

Italian italian@powerquest.com

Portuguese latina@powerquest.com

Spanish spanish@powerquest.com

Location Number

U.S.A. (801) 437-4218

Europe +31 (0)20 581 9270

http://www.powerquest.com/support/emsupport.html
http://www.powerquest.com/support
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Telephone

The U.S.A. call center is open Monday through Friday from 7 a.m. to 6 p.m., MST/MDT. 
Our European call center, located in the Netherlands, is open Monday through Friday from 
9:00 to 18:00, CET.

Postal Service Mail

Include a detailed description of your problem and a return address, a daytime phone 
number, or other relevant contact information.

Language Location Number

Dutch Netherlands +31 (0)20 581 3906

English Netherlands +31 (0)20 581 3907

English UK +44 (0)17 1341 5517

English U.S.A. (801) 226-6834

French France +33 (0)1 69 32 49 30

German Germany +49 (0)69 66 568 516

Italian Italy +39 (0)2 45 28 1312

Spanish Spain +34 (0)91 662 31 46

Spanish U.S.A. (801) 226-6834

U.S.A. Europe

PowerQuest Corporation
P.O. Box 1911
Orem, Utah 84059-1911
U.S.A.

PowerQuest Customer Service
P.O. Box 58287
1040 HG
Amsterdam, Netherlands
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